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Tools
Selection .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . V

Direct Selection  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . A

Group Selection .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift

Magic Wand . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Y

Lasso .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Q

Pen . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  P

Add Anchor Point  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  +

Delete Anchor Point .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  –

Convert Anchor Point  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+C

Type . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  T

Touch Type .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+T

Line Segment  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . \

Rectangle  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  M

Ellipse .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  L

Paintbrush . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  B

Pencil  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . N

Blob Brush . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+B

Eraser  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+E

Scissors . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  C

Rotate .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  R

Reflect  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . O

Scale  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  S

Width  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+W

Warp .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+R

Free Transform .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  E

Shape Builder . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+M

Live Paint Bucket  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  K

Live Paint Selection . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+L

Perspective Grid .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+P

Perspective Selection . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+V

Mesh .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . U

Gradient .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . G

Eyedropper, Measure .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . I

Blend . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  W

Symbol Sprayer . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+S

Column Graph  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . J

Artboard  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+O

Slice .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+K

Hand .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . H

Zoom  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Z

Toggle Fill and Stroke . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  X

Default Fill and Stroke  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . D

Swap Fill and Stroke .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+X

Color .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  ,

Gradient .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

None .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . /

Toggle 3 Screen Modes  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  F

Show/Hide All Panels .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Tab

Show/Hide All But Toolbox .  .  .  .  .  .  .  .  .  .  .  .  Shift+Tab

Increase Diameter  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . ]

Decrease Diameter .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . [

Symbolism Tools: Increase Intensity  .  .  .  .  .  . Shift+}

Symbolism Tools: Decrease Intensity  .  .  .  .  . Shift+{

Toggle Drawing Mode .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+D

Other Text
Insert Hyphen .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+-

Point Size Up .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+>

Point Size Down .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+<

Font Size Step Up .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+>

Font Size Step Down . .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+<

Kern Looser or Tighter . .  .  .  .  .  .  .  .  Shift+Cmd+] or [

Tracking .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+K

Clear Tracking  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+Q

Spacing . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+O

Uniform Type . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+X

Highlight Font  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+F

Left Align Text .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+L

Center Text .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+C

Right Align Text  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+R

Justify Text Left .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+J

Justify All Lines .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+F

Toggle Auto Hyphenation  .  .  .  Opt+Shift+Cmd+H

Toggle Line Composer  .  .  .  .  .  .  . Opt+Shift+Cmd+C

Illustrator menu
Preferences .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+K

Quit  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+Q

File
New .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+N

New from Template  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+N

Open .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+O

Browse in Bridge  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+O

Close .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+W

Save .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+S

Save As . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+S

Save a Copy .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+S

Save as Template .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Save for Web .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+S

Revert .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+Z

Place .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Export .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Other Script  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+F12

Package .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+P

Document Setup  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+P

Document Color Mode .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

File Info . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+I

Print .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+P

Edit
Undo .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+Z

Redo .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+Z

Cut .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+X

Copy  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+C

Paste .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+V

Paste in Front .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+F

Paste in Back  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+B

Paste in Place . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+V

Paste on All Artboards .  .  .  .  .  .  .  . Opt+Shift+Cmd+V

Clear  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Find and Replace .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Find Next . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Check Spelling . . . . . . . . . . . . . . . . . . . . . . . . . . . Cmd+I

Edit Colors . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Edit Original  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Color Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+K

Keyboard Shortcuts  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+K

Preferences > General .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+K

View
Outline or Preview . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+Y

Overprint Preview .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+Y

Pixel Preview .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+Y

Zoom In .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+=

Zoom Out .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+-

Fit Artboard in Window . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+0

Fit All in Window .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+0

Actual Size  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+1

Show or Hide Edges  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+H

Show or Hide Artboard .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+H

Show or Hide Print Tiling  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Show Template .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+W

Show or Hide Rulers .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+R

Change to Artboard Rulers  .  .  .  .  .  .  .  .  Opt+Cmd+R

Show or Hide Bounding Box  .  .  .  .  .  . Shift+Cmd+B

Show Transparency Grid  .  .  .  .  .  .  .  .  .  . Shift+Cmd+D

Show or Hide Text Threads  .  .  .  .  .  .  .  .  Shift+Cmd+Y

Show Gradient Annotator  .  .  .  .  .  .  .  .  .  Opt+Cmd+G

Show Live Paint Gaps . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Show or Hide Guides .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+;

Lock Guides .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+;

Make Guides .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+5

Release Guides .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+5

Clear Guides . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Smart Guides  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+U

Show or Hide Perspective Grid  .  .  .  .  . Shift+Cmd+I

Show or Hide Grid .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+’

Snap to Grid .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+’

Snap to Point .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+’

Object
Transform Again .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+D

Move . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+M

Rotate .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Reflect  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Scale  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Shear .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Transform Each . .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+D

Reset Bounding Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Bring to Front . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+]

Bring Forward  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+]

Send Backward .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+[

Send to Back  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+[

Send to Current Layer  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Group .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+G

Ungroup . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+Cmd+G

Lock > Selection . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+2

Lock > Other Layers .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Unlock All .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+2

Hide > Selection .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+3

Show All . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+3

Expand .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Expand Appearance .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Path > Join  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+J

Path > Average .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+J

Outline Stroke .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Offset Path  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Simplify  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Add Anchor Points  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Remove Anchor Points .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Divide Objects Below . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Split Into Grid . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Clean Up  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Blend > Make  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+B

Blend > Release  . .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+B

Blend > Reverse Front to Back .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Blend Options .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Make with Warp . .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+W

Make with Mesh  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+M

Make with Top Object  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+C

Envelope Distort > Release  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Edit Contents  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+P

Live Paint > Make  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+X

Text Wrap > Make .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Text Wrap > Release . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Text Wrap Options > Offset .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Clipping Mask > Make .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+7

Clipping Mask > Release . .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+7

Edit Mask . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Compound Path > Make  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+8

Compound Path > Release  .  .  .  .  .  . Opt+Sh+Cmd+8

Convert to Artboards .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Graphs  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Other Object
Lock Others  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+2

Hide Others  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+3

Repeat Pathfinder  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+4

Average & Join .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+J

Isolate Selected Object .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Exit Isolation Mode .  .  .  .  .  .  Double-click or Escape

Type
Glyphs  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Area Type Options . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Type on a Path Options .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Create Outlines .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+O

Find Font .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Change Case > UPPERCASE .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Change Case > lowercase  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Change Case > Title Case . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Change Case > Sentence case .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Smart Punctuation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Show Hidden Characters  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+I

Update All Legacy Text .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Select
All .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+A

All on Active Artboard . .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+A

Deselect . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+A

Reselect .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+6

Inverse  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Next Object Above  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+]

Next Object Below  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+[

Other Select & Misc.
Switch Selection Tools .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+Tab

Navigate to Next Document .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+̀

Navigate to Previous Doc .  .  .  .  .  .  .  .  .  .  Shift+Cmd+̀

Navigate to Next Doc Group . .  .  .  .  .  .   Opt+Cmd+̀

Nav. to Prev Doc Group . .  .  .  .  .  .  Opt+Shift+Cmd+̀

Effect
Apply Last Effect . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+E

Last Effect .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+E

Document Raster Effects Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Convert to Shape .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Path > Outline Object or Stroke . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Window
New Window . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Workspace > Manage Workspace

Workspace > Save Workspace . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Extensions > Kuler . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Control .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Minimize Window .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+M

Actions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Align  . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+F7

Appearance  . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+F6

Artboard  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Attributes  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+F11

Brushes  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  F5

Color  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  F6

Color Guide  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+F3

Document Info  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Flattener Preview .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Gradient  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+F9

Graphic Styles  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+F5

Info . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+F8

Layers  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . F7

Links  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Magic Wand . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Pathfinder  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Shift+Cmd+F9

Separations Preview .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Stroke  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+F10

Swatches .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Symbols  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+F11

Transform  . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+F8

Transparency  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+F10

Character . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+T

Character Styles  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Glyphs  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

OpenType .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Shift+Cmd+T

Paragraph .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+T

Paragraph Styles . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  

Tabs .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Shift+Cmd+T

Other Panel
New Symbol  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  F8

Add New Fill  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Cmd+/

Add New Stroke  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+/

New Layer  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Cmd+L

New Layer with Dialog  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+L

Switch Units .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Shift+Cmd+U

New File (No Dialog)  .  .  .  .  .  .  .  .  .  .  .  .  .  .  Opt+Cmd+N

Close All . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . Opt+Cmd+W

Cut, Copy, Paste (Secondary)  .  .  .  .  .  .  .  .  .  . F2, F3, F4

Help
Illustrator Help . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  F1

Welcome Screen  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  
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